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Introduction

The Exabyte® Library Monitor (Library Monitor) program is a Microsoft  Windows

software application that uses Simple Network Management Protocol (SNMP)
communications to communicate with the Exabyte library.

Library Monitor provides an easily configurable view of the data contained in the
Exabyte Library MIB (Management Information Base). A MIB is a database containing
definitions of information used to monitor, configure, and control a device on an
SNMP-based managed network. In the case of Exabyte libraries, this database
includes configuration, state, and statistics information provided by the components
and sensors within the library.

Library Monitor organizes the data fields in the MIB into display lists. The program
includes several predefined lists that allow you to view specific sets of data. For each
display list you can choose which fields to display and their order, assign a name to
each field in the list, specify how often the data is updated (the polling interval), and
specify the font and colors used for each field. In addition, you can define custom
display lists based on any of the predefined lists to easily display specific
information you want to monitor.

Library Monitor also allows you to download new firmware to the library and
upload diagnostic listing (dump) files from the library for troubleshooting.

Important  The Library Monitor program is designed for use only with Exabyte
libraries that support Exabyte MIB level 2.0 (or later). Using this program with
a library that uses an earlier version of the MIB may cause the program to fail
or behave unpredictably. The MIB version used by the library is shown in the
Library Monitor Summary display list.

About this guide
This guide provides instructions for installing and using the Library Monitor
software. It is intended for anyone who wants to use Library Monitor to view the
status of, or upgrade the firmware in, an Exabyte library. This guide assumes that
you are familiar with library operation.

Note: This User’s Guide is also available as Library Monitor’s online help.
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Conventions used in this guide
This guide uses the following conventions:

Note: Notes provide hints or suggestions about the topic or procedure being discussed.

Important  Read the information in “Important” notices to help you
successfully complete a procedure or avoid additional steps.

CAUTION

Boxed text under the heading “CAUTION” provides information you must
know to avoid losing your data or damaging your library.

When this guide instructs you to press a key, click a button, or make a selection, the
key or selection is highlighted in bold type. For example:

“Select Exit from the File menu.”
“Click Browse to open a File Selection window.”
“Press F1 for help.”

When this guide instructs you to press and hold a key while pressing another key,
the keys are shown in bold type with a hyphen between the key names. For example:

“Press Alt-F to display the items under the File menu.”

Contacting Exabyte Technical Support
Exabyte Technical Support is available in the United States from 8:00 a.m. to
6:30 p.m. Mountain Standard Time.

Phone: United States and Canada: 1-800-445-7736 or (303) 417-7792
Europe: +31-30-254-8890

Fax: (303) 417-7160 or +31-30-258-1582 (Europe)

WWW: http://www.exabyte.com

E-mail: support@exabyte.com
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Getting Started

This chapter provides the following information:

•  A list of the equipment and software required for installing and using Library
Monitor under Microsoft Windows 95, Windows 98, Windows ME, Windows
NT 4.0, or Windows 2000

•  Instructions for installing Library Monitor

•  Instructions for starting and exiting Library Monitor

•  Instructions for using the Library Monitor Windows interface

Required equipment and software
Before you start, make sure that you have the following equipment and software:

•  An IBM or compatible computer running Windows 95, Windows 98, Windows
ME, Windows NT 4.0, or Windows 2000, and equipped with the following:

•  A 3.5-inch floppy drive (if installing from floppy disk) or CD-ROM drive (if
installing from a CD)

•   A hard drive with at least 5 MB of free space available

•  An Ethernet network interface card that is supported by the version of
Microsoft Windows used

•  A Category 3 (10BaseT connection) or Category 5 (100BaseT connection) data-
grade cable

•  A color SVGA monitor (800 x 600 resolution or better)

•  A Windows compatible mouse

•  The most current version of the Exabyte Library Monitor software is available for
download from the Support Services section of Exabyte’s web site at
www.exabyte.com. You can also obtain the Library Monitor software on a floppy
disk or CD-ROM from Exabyte (see “Contacting Exabyte Technical Support” on
page vi).
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Connecting the library to the network
Before you can use your library on an Ethernet network, it must be connected to the
network and configured, as follows:

1. Verify that the Ethernet option is installed by looking for an Ethernet connector
on your library’s back panel. If your library does not include the Ethernet option,
contact Exabyte Technical Support for assistance.

2. Connect an Ethernet cable from the library’s Ethernet port to the network.

3. Using your library’s operator panel, configure the library to use static IP
addressing.

4. Set the library’s IP, Subnet, and Gateway addresses.

For detailed information about connecting the Ethernet cable and configuring the
library, refer to your library installation and operation manual.

Installing the software
Note: You may want to make a copy of your Library Monitor installation disk and store the
copy in a safe place.

Software installation is the same for all supported versions of Windows.

Installing from disk or CD

1. Start Windows.

2. Insert the Library Monitor Disk 1 into the appropriate floppy drive or the CD
into your CD-ROM drive. If you are installing from a CD, the setup program
starts automatically.

3. If you are installing from disk, select Settings from the Start menu, then open the
Control Panel folder.

4. From the Control Panel, select Add/Remove Programs.
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5. In the “Add/Remove Program Properties” dialog box, click the Install button.

6. The setup program locates and runs the file [drive]:\SETUP.EXE, where [drive] is
the letter of your floppy disk drive or CD-ROM drive. Follow the instructions as
they appear on the screen. By default, the Library Monitor software is installed in
the directory c:\Program Files\Exabyte\Library Monitor.

Note: If you are manually installing the software from a CD, run the setupex.exe
program to start the installation wizard.

The setup program copies the necessary files to your computer hard drive and
places the Library Monitor icon in the program folder of your choice. By default,
the program is placed in a folder named Exabyte.

7. When the setup is complete, remove the Library Monitor floppy disk from the
floppy drive and store it in a safe location in case you need to install the program
again later.

8. If you have microcode (*.out or *.sqs) files for your library, copy them to a
directory on your hard drive. For example, place them in a subdirectory of the
installation directory c:\Program Files\Exabyte\Library Monitor\Code.
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Installing a downloaded file

1. If you are installing the downloaded version of the software, double-click on the
file [drive]:[path]\SETUPEX.EXE, where [drive] is the letter of the drive you are
using and [path] is the path to the downloaded file. The file self-extracts and then
starts the installation wizard. Follow the instructions as they appear on the
screen. By default, the Library Monitor software is installed in the directory
c:\Program Files\Exabyte\Library Monitor.

The setup program copies the necessary files to your computer hard drive and
places the Library Monitor icon in the program folder of your choice. By default,
the program is placed in a folder named Exabyte.

2. If you have microcode (*.out or *.sqs) files for your library, copy them to a
directory on your hard drive. For example, place them in a subdirectory of the
installation directory c:\Program Files\Exabyte\Library Monitor\Code.

Uninstalling the software
To uninstall the Library Monitor software, select Add/Remove Programs from the
Control Panel. Select the Library Monitor program name from the list of installed
software and click on Remove.

Starting and quitting Library Monitor
Library Monitor uses the standard Windows user interface for text entry, option
buttons, list boxes, file selection, and help.

Starting Library Monitor

To start Library Monitor, first start Windows, then navigate to the Exabyte folder
from the Start menu and click on the Library Monitor icon. The main Library
Monitor window appears. For ease of access, you can also place a shortcut to Library
Monitor on your desktop.

Note: Library Monitor always starts with the Display and Library Device/Group settings
that were active when the program was previously closed.
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Quitting Library Monitor

To quit Library Monitor, use any of the following methods:

•  Select Exit from the File menu.

•  Double-click on the system menu box. (This is the mini-icon in the upper left
corner of the window.)

•  Click once on the system menu box and select Close.

•  Click once on the X in the upper right corner of the screen.

•  Press Alt-F4 or Alt-F x.

Accessing online help

You can access Library Monitor online help as follows:

•  Select the Help menu. The Help menu is available at the top of the main Library
Monitor window. From the Help menu, select Contents to display the contents
of the online help (similar to the table of contents in this guide). From there, you
can access information about all aspects of the Library Monitor program.

Note: The Help menu is only available from the main Library Monitor window.

•  Press F1. Pressing F1 from anywhere within the program displays the contents of
the online help.
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Using Library Monitor

Library Monitor allows you to:

•  Update the information in the MIB definition

•  Configure the information displayed by Library Monitor to meet specific
monitoring requirements

•  Organize and format the displayed information

•  View operating status and configuration information for one or more libraries

•  Download new firmware to a library

•  Upload diagnostic listings from a library

•  Change the SNMP device name and location and FTP username and password
for a library

Starting Library Monitor for the first time
When you start Library Monitor for the first time, you must perform two tasks
before beginning operation:

•  Update the initial MIB definition.

•  Configure the software to identify the libraries on the network and, optionally,
assign the libraries to groups.

Update the MIB

The first time you run Library Monitor or whenever the software detects an updated
MIB definition file, the program displays the “Update MIB Definition” dialog box.
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1. Click the Start button to update the MIB definition.

2. When the update is complete, click the Continue button to display the main
Library Monitor window.

When first displayed, the Library Monitor window does not contain any
information and the program Status icon indicates that the program is
“Stopped.”

Configure Library Monitor

Before you can view library status or configuration data, you must identify all the
libraries that you plan to monitor using the Library Monitor, as follows:

1. From the main Library Monitor window, select Configure �Libraries from the
menu bar to display the “Library IP and Group Setup” dialog box.

Status icon
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2. For each library, enter the IP address, a name to identify the library on the
display, and the Read Community String (password). The default Read
Community String is “public.” Click Add/Replace to add the library to the list of
libraries to be monitored.

Note: You can view the library’s Read Community String from the Ethernet Menu on
the library LCD.

3. If you plan to monitor multiple libraries, you can create groups to organize the
libraries according to some criteria. For example, you can create a group that
contains all of the libraries at a specific location. For each group, type the name in
the Group text box and click Add to add the group to the list of groups.

4. To assign a library to a group, select the group name from the pull-down list.
Double-click on the name of the library in the list of libraries or use the move
arrow to assign it to the selected group.

5. After you enter the IP addresses and names for all of the libraries and groups
you want to monitor, click OK to close the window and redisplay the main
Library Monitor window.

6. Select one of the predefined display lists from the Display pull-down list, then
select the library or group name you want to monitor from the From Library
Device/Group pull-down list. The main Library Monitor window changes to
display the data specified in the display list for the selected library or group of
libraries.

Status icon

Display panel
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Features of the Library Monitor main window

The main Library Monitor window includes the following standard features:

•  Status icon – Indicates the general operating status of the program, as follows:

The data display updates are under manual control, either
because no libraries have been configured for monitoring or
because the polling interval for the selected display list is set
to zero seconds. To update the displayed data with the latest
values from the library, click the Refresh button or set the
polling interval.

The automatic update of the data display has been
suspended. When the polling interval is greater than
zero seconds, the program automatically updates the
displayed data. You can suspend this update by clicking the
Pause button. To resume polling, click the Resume button.

The program is operating in automatic update mode
(polling) and is waiting for the update interval to expire. A
countdown timer below the “next update” line indicates how
many seconds remain until the next automatic update.

The program is obtaining the latest values from the library
(or group of libraries). As the data for each library or library
element becomes available, the values are immediately
displayed on the screen.

The program was unable to obtain any (or all) data items
selected for display from the library, due to an Ethernet
communication failure or a MIB data lookup failure. An
error message displayed in place of the affected field value
indicates what caused the error. For example, this error
appears if a field is currently undefined in the MIB.

The library reported an error condition. An error message in
the stsErrorCode and stsErrorText fields (if they are
included in your currently selected display list) indicates
what caused the error.
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•  Display – The name of the currently selected display list. The display lists allow
you to selectively monitor predefined groups of data fields. Use the pull-down
list to select the display list that contains the information you want to display.
The data from the selected list appears in the display panel of the Library
Monitor window. See “Appendix A – Standard Display Lists,” beginning on
page 31, for descriptions of the predefined display lists included with Library
Monitor.

•  From Library Device/Group –The library or group of libraries currently being
monitored. Use the pull-down list to select the library or group of libraries you
want to monitor.

•  Polling Interval – The current setting for the polling interval, as follows:

•  Disabled indicates that the polling interval for the display list is set to zero.
•  n seconds, where n is the polling interval defined for the display list.
•  n seconds – Paused indicates that polling has been suspended by clicking the

Pause button.

•  Clock (not labeled) – Located immediately above the From Library
Device/Group list box, the clock display shows the current time of day, using the
hh:mm:ss format. The clock provides confirmation that the program is running
correctly (that is, not hung) even when the Status icon indicates an error.

•  Display Panel – Contains the information specified in the selected display list for
the selected library or group of libraries.

If the columns in the display panel are too narrow for the complete field value to
be visible, an ellipsis, “…”, at the end of the field indicates that the displayed
value is truncated.

To temporarily display the entire value, place your cursor over a truncated field
value.

To resize a column width or row height, drag the separator bar between two
columns or rows. Double clicking the separator bar resizes the column to the left
or the row above the separator bar, respectively.

See “Appendix B – Exabyte Library MIB Field Listing,” beginning on page 32, for
a list of the fields that can appear in the display panel and the possible values for
each.

Refresh

Clicking the Refresh button causes the Library Monitor to retrieve the current data
from the selected library or group of libraries and use it to update the display list
values in the display panel. The display list can be updated whenever the program is
in the Stopped, Paused, or Sleeping state.

Pause/Resume

Clicking the Pause button temporarily suspends the automatic update of the
displayed data fields. The Status icon changes to Paused and the Polling Interval
timer indicates that polling is paused. To resume automatic polling, click Resume.
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Library Monitor menu options

The Library Monitor window menu bar provides the following additional program
controls and operations.

File menu

The File menu provides the following options:

•  Load Code – Allows you to select a firmware update file and send it to the
library.

•  Write Dump – Allows you to request a diagnostic dump file from the library.

•  Exit – Exits Library Monitor.

See “Updating library firmware,” beginning on page 23, for information about using
these menu options.

Display menu

The Display menu provides options for selecting which data fields from the MIB are
displayed and specifying how that data is formatted, as follows:

•  Select Fields – Allows you to select and organize the fields in the display list. For
each field you can specify whether the data appears on the display and assign a
User Name. You can choose to display the data in columns or rows, change the
order in which the fields are displayed, choose to display the raw MIB data,
specify whether the MIB field names, user field names, or both are displayed,
and restore the default field ordering.

•  Format Fields – Allows you to select the font, text color, and background color
for each field in the display list. You can also choose to have the columns resize
automatically to prevent the displayed data from being truncated if the column
is too narrow.

•  Custom Lists – Allows you to create customized display lists based on one of the
predefined display lists.

•  Delete List – Allows you to select and delete a custom display list.

•  Polling Interval – Allows you to set the polling interval (in seconds) for the
automatic update of the data display.

•  Highlights – Allows you to define the conditions under which selected fields in
the data display are highlighted using an alternate font, text color, or background
color.

•  Logging – Allows you to capture the display data in an ASCII text file for future
analysis. The options under this menu will be available in a future version of
Library Monitor.

See “Customizing the data display,” beginning on page 13, for information about
using these menu options.



12 Exabyte Library Monitor Software for Windows

Alerts menu

The Alerts menu allows you to define conditions under which alerts are sent to an
operator. The options under this menu will be available in a future version of
Library Monitor.

Configure menu

The Configure menu provides options for configuring the Library Monitor software,
as follows:

•  Libraries – Allows you to set up the program to monitor individual libraries and
groups of libraries. For each library, you specify the IP address, a name, and the
Read Community String. You can create named groups of libraries to be
monitored simultaneously.

•  Directories – Allows you specify the default directories for codeload files,
diagnostic listing (dump) files, and log files.

•  Change Data – Allows you to change the FTP Username and Password for each
library. You can also change the SNMP Management device name and location
information for each library.

See “Configuring Library Monitor,” beginning on page 27, for information about
using these menu options.

Window menu

The Window menu provides the following options for controlling how the
information in a display list fits on the screen:

•  AutoSize Columns – Automatically resizes the widths of all the columns in the
display list so that all of the currently displayed text is visible.

•  AutoSize Rows – Automatically resizes the heights of all the rows in the display
list so that all of the currently displayed text is visible.

•  Fit to Window – Resizes all column widths and row heights to fit the current
window size.

•  Reset – Restores all column widths and row heights settings to their default
values.

Help menu

The Contents option under the Help menu displays the User’s Guide in Windows
help format.
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Customizing the data display
The information that appears in the display panel of the Library Monitor window is
determined by choosing a previously defined display list. A display list takes groups
of related data fields from the library MIB and presents them in the display panel.
Library Monitor allows you to customize how this data is displayed. You can choose
the fields that are of interest from a previously defined display list, change the
names of the data fields to be more meaningful to you, use different fonts and colors
to make groups of data easier to distinguish, and change the order of the data in the
display. If none of the predefined lists contains all of the data you want to see, you
can create custom display lists tailored to your specific requirements.

The following sections describe how to customize Library Monitor so that it provides
the information you need, formatted the way you want it.

Modifying a display list

Library Monitor includes a number of predefined display lists. These display lists
may include data fields that you are not interested in monitoring or the data may not
be organized as you would like.

Use the following steps to modify the data included in a display list.

Note: These steps can also be used to further refine the data included in a custom display list.

1. Choose the display list you want to customize from the Display pull-down list on
the main Library Monitor window.

2. Select Display � Select Fields from the menu bar to display the “Select Data
Fields for Display” dialog box.

Data field
panel
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The “Select Data Fields for Display” data field panel contains the following
information:

•  MIB Field Name – The name of the data field in the MIB. The names in this
column cannot be changed.

•  MIB OID – The SNMP address of the data field in the MIB. This information
is useful if you want to directly access this data field using some other
monitoring software.

•  User Field Name – A user-specified name for the data field.

•  Display – A check box to control whether or not the data field is included in
the display list.

3. Use the following options to configure the display list, as desired.

•  Select which fields to display or hide.

To include the value for a field in the display list, click the check box in the
Display column for the field. To hide the value for a field, click the Display
column check box again to clear the check mark. You can also use the
Display All or Hide All buttons to globally display or hide all of the fields in
the list.

See “Appendix B – Exabyte Library MIB Field Listing,” beginning on page 32,
for a list of the fields that can appear in the display panel and the possible
values for each.

•  Change the order in which the fields appear in the display list and
restore the default order.

To change the display order for a field, click on the field name in the data
field panel to select the row, then click the Move Up or Move Down buttons
to change the position of the field. To restore the original display order, click
the Default Field Order button.

•  Assign a user name to the field.

To change the User Field Name for any field, click in the User Field Name
box and type the new name. Each field has a default, “plain-English” name.

Note: Refer to “Appendix B – Exabyte Library MIB Field Listing,” beginning on
page 32, if you want to restore the default user name for a field.

•  Choose how the data field names appear in the display list.

To display only the MIB Field Names for the data fields, click the MIB
Definition radio button. To display only the User Field Names, click the User
Defined radio button. To display both names, click the Both Names radio
button.

Note: This setting affects all display lists, not just the one currently being
configured.
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Displaying the MIB Field Name is particularly useful during troubleshooting
procedures if you changed the default User Field Name for one or more of
the data fields.

•  Choose whether to display the numeric value of the data fields in the
display list.

Some of the MIB data fields contain numeric codes. By default, Library
Monitor translates these numeric codes to more meaningful alphanumeric
character strings. To view the numeric codes for these data fields, click the
Display Raw Data Values radio button.

Note: This setting affects all display lists, not just the one currently being
configured.

For example, the MIB reports the host interface type as a number from 1 to 5.
By default, Library Monitor interprets this raw data and displays the
corresponding character string; in this case, None, LVD, HVD, LVD-SE
mode, or LVD-HVD mode, respectively. Displaying the uninterrupted raw
numbers can be useful when troubleshooting problems with a library or
Library Monitor.

•  Choose whether you want to display the data fields as rows or columns.

To display the data fields as rows in a table, click the In Rows radio button.
To display the data fields in columns, click the In Columns radio button.

When you display the data fields as rows, each column contains the selected
data fields for the library or libraries you specified in the From
Library/Group pull-down list. Conversely, when you display the data fields
as columns, each row contains the selected data fields for the library or
libraries you specified in the From Library/Group pull-down list.

•  Choose which elements you want to include.

For display lists that include multiple elements in a single library, click the
All radio button to display data for all of the elements. To specify a range of
elements for display, click the From radio button and enter the number for
the first element in the From box; enter the number for the last element in the
To box. If you want to display data for a single element, enter the same
element number in the From and To boxes.

For example, to include only the data fields pertaining to cartridge slots 1
through 20 in the Exabyte 430M in the Cartridge Slots display list, click the
From radio button and type 1 in the From box; type 20 in the To box.

4. After you finish making your selections, click the OK button to save the new
settings, or the Cancel button to discard the changes you made. If you click the
OK button, the display list is updated to reflect your changes and the values for
the data fields are updated. Any changes you make remain in effect until you
change them again.
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Formatting a display list

In addition to selecting the data fields included in a display list, you can also
customize the appearance of the data fields in the display panel of the Library
Monitor window.

Use the following steps to customize the appearance of the data fields.

1. Choose the display list you want to format from the Display pull-down list on
the main Library Monitor window.

2. Select Display � Format Fields from the menu bar to display the “Select Font
and Color” dialog box.

3. From the “Select Font and Color” dialog box, click the Show All Fields radio
button if you want to format all of the fields in the display list, including the ones
that are not currently selected for display. To format only the fields currently
selected for display in the “Select Fields” dialog box, click the Show Visible
Fields radio button.

4. In the data field panel portion of the “Select Font and Color” dialog box, select
the field you want to format. To select a range of fields, hold down Shift and
select the first and last fields in the range. To select multiple, non-adjacent fields,
hold down the Ctrl button on your keyboard as you select the desired fields.

Data field
panel
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5. Use the following options to customize the fonts and colors used to display the
selected fields.

•  Select the font used for the column and row headings.

To select the font for row and column heading text, click the Select button in
the “Heading Font” group box. The standard Windows font selection dialog
box appears, from which you can select the font name, style, and point size
for the headings.

To restore the default font for the column headings, click the Default button
in the “Heading Font” group box.

•  Select the text and background colors used for the column and row
headings.

To select the colors for the heading font and background, click the Select
button in the “Heading Colors” group box. The “Select Text and Background
Colors” dialog box appears:

To change the color of the text, click the Select Text Color button. To change
the color of the background, click the Select Background Color button. In
either case, the standard Windows color selection dialog box appears, from
which you can select a predefined basic color or define and apply a custom
color definition. After selecting the desired colors, click OK.

To remove the selection highlight and view the result of your changes, click
the Clear Selection button.

To restore the default colors for the headings, click the Default button in the
Heading Colors group box.

•  Select the font used for the individual data fields.

To select the font for a data field, select the desired field, then click the Select
button in the “Field Font” group box. The standard Windows font selection
dialog box appears, from which you can select the font name, style, and point
size for the field. When you specify a font for a field, the font is applied to
both the heading text and the field value text for the field.

To restore the default font for the selected field, click the Default button in
the “Field Font” group box.

Note: If you specify both a heading font and a field font, the field font overrides the
heading font for the field name text.
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•  Select the text and background colors used for a selected data field.

To select the colors for a heading font and background, click the Select
button in the “Heading Colors” group box. The “Select Text and Background
Colors” dialog box appears.

To change the color of the text, click the Select Text Color button. To change
the color of the background, click the Select Background Color button. In
either case, the standard Windows color selection dialog box appears, from
which you can select a pre-defined basic color or define and apply a custom
color definition. After selecting the desired colors, click OK.

To remove the selection highlight and view the result of you changes, click
the Clear Selection button.

To restore the default colors for the column headings, click the Default
button in the Field Colors group box.

•  Choose whether you want to automatically adjust the column widths.

To have the column widths change to automatically adjust to the width of the
data each time the data field is updated, click the Automatic Column
AutoSize radio button.

By default, Library Monitor automatically sets the width of the columns the
first time a new display list is selected. Choosing this option causes Library
Monitor to resize the columns whenever the value in a field is updated.

If the width of a column is too narrow for the complete field value to be
visible, an ellipsis, “…”, appears at the end of the field to indicate that the
displayed value is truncated. To temporarily display the entire value, place
your cursor over a truncated field value.

6. After you finish making your selections, click the OK button to save the new
settings, or the Cancel button to discard the changes you made. If you click the
OK button, the display list is updated to reflect your changes and the values for
the data fields are updated. Any changes you make remain in effect until you
change them again.

Creating custom display lists

If none of the predefined display lists contains the right combination of data that you
want to monitor, you can create custom display lists tailored to your specific
requirements. These custom display lists are based either on an existing display list,
or on a special list called All Library Fields. The All Library Fields list contains all of
the data fields included in the General, Configuration, Status, and System
Components display lists.
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Use the following steps to create a custom display list.

1. Select Display � Custom Lists from the Library Monitor menu bar to display
the “Create New Custom List” dialog box.

2. Type a name for the new display list in the Name text box. Select a previously
defined display list from the Based on pull-down list. This display list will be
used as the basis for the new display list. See “Appendix A – Standard Display
Lists,” beginning on page 31, for descriptions of the predefined display lists
included with Library Monitor. An additional list called All Library Fields
contains all of the data fields included in the General, Configuration, Status, and
System Components display lists.

3. Click the OK button. The Select Fields dialog box is displayed. Using this dialog
box, you specify which data fields you want to include in your custom display,
as described in “Modifying a display list,” beginning on page 13.

By default, none of the fields in the new display list are selected for display. To
select all of the fields, click the Display All button.

See “Appendix B – Exabyte Library MIB Field Listing,” beginning on page 32, for
a list of the fields that can appear in the display panel and the possible values for
each.

4. After you configure the new display list, click OK. The data from the new list
appears in the display panel of the Library Monitor window.

5. If desired, format the new display list as described in “Formatting a display list,”
beginning on page 16.

Updating display list information automatically

When you first start Library Monitor, all of the data for the selected library or group
of libraries is automatically updated one time and then remains static until you click
either the Refresh or Resume button. If desired, you can configure Library Monitor
to automatically update the information in the selected display list at regular time
intervals (the polling interval). Each display list can have a different polling interval.

Use the following steps to establish a polling interval for a display list.

1. Choose the display list for which you want to set up automatic polling from the
Display pull-down list on the main Library Monitor window.
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2. Select Display � Polling Interval from the menu bar to display the “Set Polling
Interval” dialog box. The name of the active display list appears above the
polling interval edit box.

3. Type a number from 1 to 3600 in the Polling Interval box to specify how often, in
seconds, the display values are updated. To disable automatic updates, set the
polling interval value to zero.

Highlighting selected operating conditions

Library Monitor allows you to configure custom highlights for a data field when the
field value meets specific criteria. These visual indicators provide an easy way to
quickly identify an error condition or a value that is outside an expected operating
range. Each data field can have its own set of highlight conditions.

When you enable highlighting, Library Monitor compares the current value for a
data field against a set of criteria defined for the field and highlights the field if the
current value meets those criteria. This comparison occurs every time the display is
updated, either automatically or manually. The characteristics of a highlight can
include an alternate font, text, and background color for the displayed value. If
desired, you can also define conditions under which the highlight is removed for a
field value.

Note: Setting up highlights only affects the displayed data. The monitored conditions are not
saved in a history or log file. If you are not watching the main Library Monitor window when
a highlight occurs, and you have defined a reset condition for the highlight, you may
completely miss the occurrence.

Creating a new highlight condition

Use the following steps to set up highlights for a specific data field.

1. Select Display � Highlights from the Library Monitor menu bar to display the
“Define Field Highlights” dialog box.

Note: To make identifying the data fields you want to highlight easier, use the Select
Fields option under the Display menu to turn on the display MIB field names option, if it
is not already turned on (see page 13).
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2. Select the MIB field for which you want to specify highlight criteria.

3. Use the following options to customize the font, display text, background color,
test conditions, and reset condition for the field highlight, as desired.

•  Select the font used for the highlighted data field.

To use a different font for a highlighted data field, click the Change Font to
check box, then click the Select Font button. The standard Windows font
selection dialog box appears, from which you can select the font name, style,
and point size for the field.

•  Select the text and background colors used for the highlighted data
field.

To select the text and background colors used to highlight a data field, click
the Change Colors to check box, then click the Select Colors button. The
“Select Text and Background Colors” dialog box appears.

To change the color of the text, click the Select Text Color button. To change
the color of the background, click the Select Background Color button. In
either case, the standard Windows color selection dialog box appears, from
which you can select a pre-defined basic color or define and apply a custom
color definition. After selecting the desired colors, click OK.
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•  Define the condition required to activate the highlight.

The “Condition” group box provides three different types of test criteria that
can be used to activate a highlight:

Value Test – Allows you to specify a value or range of values to be matched
in a numeric data field. To activate the highlight whenever the field value is
less than a specified value, enter the threshold number in the Less Than box
and leave the Greater Than box blank. To activate the highlight whenever
the field value is greater than a specified value, enter the threshold value in
the Greater Than box and leave the Less Than box blank. To activate the
highlight whenever the field value is either less than a specified value or
greater than another value, enter the two threshold values in the Less Than
and Greater Than boxes, respectively.

String Match – Allows you to specify an alphanumeric string to be matched
in a text data field. Enter the alphanumeric string to be matched into the text
box. Select Exact Match if the selected data field must exactly match the
string you entered. Select Prefix if only the first part of the selected data field
needs to match the string you entered (that is, there can be additional
characters following the matched string). Select Contains if the string you
entered can appear anywhere in the data field value. To further constrain the
matched data field string to use the same case for all the characters as you
entered in the text box, click the Case Sensitive check box. By default, the
string comparisons are not case sensitive.

Any Change in Displayed Value – Allows you to highlight a field whenever
the displayed value changes from one update to the next.

•  Define the condition required to reset the highlight.

The “Reset Highlight” group box provides three different types of test
criteria that can be used to turn off (reset) a highlight:

Value Test – The highlight is reset when the numeric value specified for a
Value test is back in range.

String Match – The highlight is reset when the data field string no longer
matches the specified string.

Any Changes in Displayed Value – The highlight is reset whenever the
value for the selected field does not change for a specified number of update
intervals. For example, if you enter zero in the After box, the highlight is
reset the next time the display is updated, if the value did not change. If you
enter 10 in the After box, the highlight is reset only if the value does not
change for the next ten times the display is updated. This reset option applies
to either automatic or manual updates.

4. After you define the highlight characteristics for the MIB field you want to track,
click the Add button to add the highlight definition to the “Currently Defined
Field Highlights” list.

5. If desired, repeat steps 2 through 4 to set up highlights for additional MIB fields.

6. Click OK to activate the highlight definitions.
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Modifying or deleting an existing highlight definition

Use the following steps to modify a highlight definition or to create a new highlight
definition based on an existing definition.

1. Select the Display � Highlights from the Library Monitor menu bar to display
the “Define Field Highlights” dialog box.

2. Double-click the highlight definition you want to change in the Currently
Defined Field Highlights list box. The settings for the highlight are displayed in
the upper part of the dialog box. Change the settings as desired.

3. To replace the previous definition with the new one, click the Replace button. If
you want to save the new settings as a new definition, click the Add button.

4. To remove a highlight definition, click once on the highlight definition in the
Currently Defined Field Highlights list box, then click the Remove button.

5. Click OK to activate the updated highlight definitions.

Updating library firmware
From time to time, Exabyte releases updates to the library firmware. These updates
add new features or correct errors. You can use Library Monitor to load new
firmware into your library.

CAUTION

Do not update firmware unless Exabyte Technical Support has advised you to
do so. If performed improperly, the upgrade procedure can render your library
inoperable. Consult with Exabyte Technical Support before performing an
upgrade.

To upgrade the library firmware:

1. Obtain new firmware for the library. You can download new firmware from
Exabyte’s web site (www.exabyte.com), or you can contact Exabyte Technical
Support (see page vi).

2. Select the library that you want to upgrade from the Library Device/Group pull-
down list. You can only update one library at a time.

3. Select File � Load Code from the Library Monitor menu bar to display the
“Select Library Code File” dialog box.
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4. Navigate to the directory where you stored the firmware update file. By default,
Library Monitor expects the file to be located in the directory you specified using
the Configure � Directories option (see “Specifying default file locations” on
page 29).

5. Select the name of the code file you want to use, then click the Open button.

After you select the file, the Confirm Code File Transfer dialog box appears.
This dialog box displays the target library and source code file. Enter the FTP
User Name and Password for the target library.

The default FTP user name is “anonymous.” The default FTP password is
“Exabyte.” You can change these values from the Configure � Change Data
dialog box (see “Changing a MIB data field” on page 29). If you do not know the
current settings, you can view them from the library’s operator panel. Refer to
your library’s documentation for information.

Note: Both the FTP user name and password are case-sensitive.

6. Click OK. A progress message box shows the progress of the update process.
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7. When the file transfer is complete, the progress message box closes
automatically. Wait for 60 to 90 seconds while the library erases the old
firmware, reprograms flash memory, and performs a power-on self-test.

CAUTION

Do not attempt to perform library operations or power down the library until
after the library automatically resets.

Creating a diagnostic listing (dump) file
If you report a problem to Exabyte Technical Support, you may be asked to create a
library diagnostic listing (also called a dump or trace). A diagnostic listing is created
when you use Library Monitor to send an ASCII text copy of the library’s diagnostic
buffer from the library to the host computer. This buffer information can be used by
support personnel to troubleshoot incidents with the library.

Use the following steps to create a diagnostic listing file from the library.

1. Select the library from which you want to obtain the diagnostic listing using the
Library Device/Group pull-down list.

2. Select File � Write Dump from the Library Monitor menu bar to display the
“Select Library Dump File” dialog box.



26 Exabyte Library Monitor Software for Windows

3. Navigate to the directory where you want to store the diagnostic listing. By
default, Library Monitor expects the file to be located in the directory you
specified using the Configure � Directories option (see “Specifying default file
locations” on page 29).

4. Enter a name for the file to contain the diagnostic listing or select the name of an
existing file. The default filename is libtrace.txt.

5. Click the Save button. The “Confirm Dump File Transfer” dialog box appears.
This dialog box displays the source library and the name of the diagnostic listing
file. Enter the FTP User Name and Password for the target library.

The default FTP User Name is “anonymous,” the default FTP password is
“Exabyte.” You can change the FTP Username and Password from the
Configure � Change Data dialog box (see “Changing a MIB data field” on
page 29). If you do not know the current settings, you can view them from the
library’s operator panel. Refer to your library’s documentation for information.

Note: Both the FTP user name and password are case-sensitive.

6. Click OK. A progress message box shows the progress of the file transfer.

7. When the diagnostic data transfer from the library is complete and data is
written to the specified file, the progress message box closes automatically. The
diagnostic listing is saved in ASCII format and can be viewed in any text editor.
Diagnostic listing files are approximately 300 KB in size.
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Configuring Library Monitor
Before you can use Library Monitor to monitor a library, you must add it to the list
of libraries you set up when you first started the program (see “Configure Library
Monitor,” beginning on page 7). You can also create named groups of libraries and
assign libraries to those groups. The groups can then be monitored simultaneously
for those display lists that support multiple libraries.

In addition to configuring the libraries and groups of libraries monitored by the
software, you can specify default file locations for library firmware update files,
diagnostic listing files, and log files. You can also change the FTP Username and
Password for the library.

Adding, modifying, or removing a library to Library Monitor

Use the following steps to add a library to the list of libraries being monitored.

1. Select Configure � Libraries from the Library Monitor menu bar to display the
“Library IP and Group Setup” dialog box.

2. For each library, enter the IP address, a name to identify the library on the
display, and the Read Community String (password). The default Read
Community String is “public.” Click Add/Replace to add the library to the list of
libraries to be monitored.

3. After you enter the IP Addresses and Names for all of the libraries you want to
monitor, click OK to close the window and redisplay the main Library Monitor
window. Any libraries that you defined can now be selected from the From
Library Device/Group pull-down list on the main Library Monitor window.
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Use the following steps to remove a library from the list.

1. Select Configure � Libraries from the menu bar to display the “Library IP and
Group Setup” dialog box.

2. Click once on the name of the library you want to remove from the list of
libraries.

3. Click the Remove button.

Use the following steps to modify the definition of a library entry.

1. Select Configure �Libraries from the menu bar to display the “Library IP and
Group Setup” dialog box.

2. Double-click on the name of the library you want to modify. The settings for that
library are displayed in the upper portion of the dialog box.

3. Click the Add/Replace button.

If you change the IP Address, clicking the Add/Replace button adds a new entry
to the list. If you change either the Name or Read Community String fields, but
leave the IP Address unchanged, clicking the Add/Replace button modifies the
previous definition for the selected library.

Whenever you add or modify a library in the list, Library Monitor performs a
quick test to determine whether the library can be contacted on the network. If
the software receives a response from the library, it is added to the list. If the
library does not respond, the program notifies you that the library cannot be
contacted. You are then given the option to add the library entry to the list
anyway.

Defining, modifying, or deleting a library group

If you plan to monitor multiple libraries, you can create groups to organize the
libraries according to some criteria. For example, you could create a group that
contains all of the libraries at a specific location.

1. Select Configure � Libraries from the Library Monitor menu bar to display the
“Library IP and Group Setup” dialog box.

2. For each group, type the name in the Group text box and click Add to add the
group to the list of groups.

3. To assign a library to a group, select the group name from the pull-down list.
Double-click the name of the library in the list of libraries or use the move arrow
to assign it to the selected group. A library can be added to multiple groups or it
can be added to a single group multiple times.

4. To remove a library from a group, select the library entry from the group list and
click the Remove button.
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5. To delete a library group, you must first select and remove all of the individual
library entries in the list, and then click the Remove button to delete the group.

6. After you set up all of the library groups you want to monitor, click OK to close
the window and redisplay the main Library Monitor window. Any of the library
groups that you defined can now be selected from the From Library
Device/Group pull-down list on the main Library Monitor window.

Specifying default file locations

In addition to its monitor functions, Library Monitor allows you to load new
firmware into the library and capture diagnostic and logging information. For each
of these activities, you can specify a default directory for the files used.

Use the following steps to specify the default directory locations for code files,
diagnostic listing (dump) files, and log files.

1. Select Configure � Directories from the Library Monitor menu bar to display
the “Select Default Directories” dialog box.

2. For each file type, type the full directory path into the text box or click the
Browse button and navigate to the desired directory.

3. After specifying the default directory for each file type, click OK.

Changing a MIB data field

Library Monitor allows you to change the FTP Username and Password for each
library. You can also change the SNMP Management device name and location
information for each library.

Use the following steps to change the information stored in the MIB for a specific
library.

1. Select the library you want to modify from the Library Device/Group pull-down
list.

2. Select Configure � Change Data from the Library Monitor menu bar to display
the “Change Field Data” dialog box.
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3. Select the field you want to change from the Select Field pull-down list. The
current value for the field is displayed in the Field Value text box. The following
four fields in the MIB can be changed:

•  cfgFTPassword – The FTP Password for the library. The default password is
“Exabyte.” If you do not know the current FTP Password, you can view it
from the library’s operator panel. Refer to your library’s documentation for
information.  

•  cfgFTUserName – The FTP Username for the library. The default user name
is “anonymous.” If you do not know the current FTP Username, you can
view it from the library’s operator panel. Refer to your library’s
documentation for information.

•  snmpLibraryLocation – The physical location of the library. The default
location is “Boulder, CO.” This field is defined as part of the standard SNMP
management MIB. It is not uniquely defined in the Exabyte library MIB.

•  snmpLibraryName – The name used to identify the library. The default
name is the same as the product name displayed on the library front panel.
This field is defined as part of the standard SNMP management MIB. It is not
uniquely defined in the Exabyte library MIB.

Note: Both the FTP user name and password are case-sensitive.

4. Type the new value for the selected field in the Field Value text box.

5. Type the library’s Write Community String in the Write Community String
(password) text box. The default Write Community String is “public.”

Note: The Write Community String is case-sensitive.

6. Click the Write button to save your changes. As the new field values are written
to the library’s MIB, the message box above the buttons displays the status. If an
error occurs, the status displays a message to indicate what failed.
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Appendix A – Standard Display Lists
Library Monitor includes the following predefined standard display lists:

•  Summary – Lists identification and status information for each library or group
of libraries. The status includes information displayed on the library’s LCD for
the library itself and each of its tape drives.

•  General – Lists the Inquiry data, community strings, and code versions for each
library or group of libraries. This list includes all of the MIB data fields that have
a gen prefix.

•  Configuration – Lists configuration information for each library or group of
libraries. The list includes all of the MIB data fields that have a cfg prefix.

•  Status – Lists the status information currently displayed on the library LCD. This
list also includes the library statistics and the status of the library sensors. The
Status list includes all of the MIB data fields that have an sts prefix.

•  System Components – Lists the number and status of the system components in
each library or group of libraries. These components include the power supply,
door and entry/exit port sensors, and fans.

•  Cartridge Slots – Lists the MIB data fields associated with the data storage
elements (the cartridge slots) in a selected library. This list cannot be used with a
group of libraries. The list includes all of the MIB data fields that have an mse
(media storage elements) prefix.

•  Tape Drives – Lists the MIB data fields associated with the tape drives in a
selected library. This list cannot be used with a group of libraries. The list
includes all of the MIB data fields that have an mae (media access elements)
prefix.

•  Robots – Lists the MIB data fields associated with the robots in a selected library.
This list cannot be used with a group of libraries. The list includes all of the MIB
data fields that have an mte (media transfer elements) prefix.

•  Entry-Exit Slots – Lists the MIB data fields associated with the entry/exit port
for a selected library. If the library does not include an entry/exit port, these
fields are blank. This list cannot be used with a group of libraries. The list
includes all of the MIB data fields that have an mie (media import/export
elements) prefix.

•  Power Supply Detail – Lists the status information for all of the power supplies
in the selected library. This list cannot be used with a group of libraries. The list
includes all of the MIB data fields that have a pst (power supply status) prefix.

•  Fan Detail – Lists the status information for all of the fans in the selected library.
This list cannot be used with a group of libraries. The list includes all of the MIB
data fields that have a sf (system fan) prefix.

•  Product Specific Sensors – Lists status information for any other library sensors
that are not included in one of the other lists. This list cannot be used with a
group of libraries. The list includes all of the MIB data fields that have a pss
(product specific sensors) prefix.
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Appendix B – Exabyte Library MIB Field
Listing

This appendix lists only the fields unique to the Exabyte library MIB. It does not
include fields that are defined in the standard SNMP management MIB. If a library
does not include a particular element or sensor, the MIB field either contains all
zeros or is blank. Product specific sensors depend on the library being monitored
and library firmware version.

MIB Field Name Default User
Field Name

Display Value
(Raw Data)

SNMP
Data
Type

Description

mibVersion MIB Version Alphanumeric string,
up to 11 characters

String The Exabyte Library MIB version
number.

General Library Information

genDataStatus Data Status Uninitialized (0)
Initializing (1)
Initialized (2)

4-byte
Boolean
integer

The status of the MIB data fields

genLibraryName Library Name Alphanumeric string
(upper or lower case)

String The product name displayed on the
library LCD.a

genInqVendorID Inquiry Vendor
ID

Alphanumeric string,
up to 8 characters
(upper or lower case)

String The ASCII representation of the
Vendor ID returned when you issue
an INQUIRY command to the
library.

genInqProductID Inquiry Product
ID

Alphanumeric string,
up to 16 characters
(upper or lower case)

String The ASCII representation of the
Product ID returned when you
issue an INQUIRY command to the
library.

genInqProductRevision Inquiry Product
Revision

Alphanumeric string,
up to 4 characters
(upper or lower case)

String The ASCII representation of the
Product Revision returned when
you issue an INQUIRY command
to the library.

genInqSerialNumber Library Serial
Number

Alphanumeric string,
up to 10 characters
(upper or lower case)

String The ASCII representation of the
library serial number.

genNativeID Native Product
ID

Alphanumeric string,
up to 16 characters
(upper or lower case)

String The Product ID returned when you
issue an INQUIRY command to the
library when the library is not
operating in emulation mode.

genReadCommunityString Read
Community
String

Alphanumeric string,
up to 20 characters

String One of the community strings
contained in the SNMP
administration framework. (You
can view the Read Community
String from the library’s LCD.)b

genWriteCommunityString Write Community
String

Alphanumeric string,
up to 20 characters

String One of the community strings
contained in the SNMP
administration framework. (You
can view the Write Community
String from the library’s LCD.) b
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MIB Field Name Default User
Field Name

Display Value
(Raw Data)

SNMP
Data
Type

Description

genBroadcastCommunityString Broadcast
Community
String

Alphanumeric string,
up to 20 characters

String One of the community strings
contained in the SNMP
administration framework. (You
can view the Broadcast Community
String from the library’s LCD.) b

genEthernetBootCodeVersion Ethernet Boot
Code Version

Alphanumeric string,
up to 11 characters

String The version level of the boot code
for the library’s Ethernet card. For
more information about the latest
Ethernet boot code version for your
library, refer to Exabyte Firmware
Upgrades in the Support Services
section of the Exabyte web site.c

genEthernetCodeVersion Ethernet Code
Version

Alphanumeric string,
up to 11 characters

String The version level Ethernet flash
code for the library’s Ethernet card.
For more information about the
latest Ethernet flash version for
your library, refer to Exabyte
Firmware Upgrades in the Support
Services section of the Exabyte
web site.c

genLibraryBootCodeVersion Library Boot
Code Version

Alphanumeric string,
up to 11 characters

String The version level of the library's
boot code. For more information
about the latest boot code version
for your library, refer to Exabyte
Firmware Upgrades in the Support
Services section of the Exabyte
web site.

genLibraryCodeVersion Library Code
Version

Alphanumeric string,
up to 11 characters

String The version level of the library's
flash code. For more information
about the latest flash code version,
refer to Exabyte Firmware
Upgrades in the Support Services
section of the Exabyte web site.

genLCDorInquiryProductName Library or Inquiry
Name

Alphanumeric string,
up to 20 characters
(upper or lower case)

String The text displayed on line 1 of the
library LCD when there are no
other messages. If the library is
operating in an emulation mode,
this field contains the Product ID
returned when you issue a SCSI
INQUIRY command to the library.
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MIB Field Name Default User
Field Name

Display Value
(Raw Data)

SNMP
Data
Type

Description

Library Configuration Information

cfgIPCurrent Library IP
Address

n.n.n.n

Where n is a three-
digit number
(0-255)

4-byte
integer

The IP address of the SNMP
device (in this case, the library).
This value can be changed from
the library operator panel.

cfgIPFixed IP Address Fixed Yes (static IP
address)

No (assigned
dynamically)

4-byte
Boolean
integer

Indicates whether the library’s IP
address is fixed (static) or has
been assigned dynamically through
DHCP. To change this value, use
the library’s operator panel.d

cfgIPSubnet IP Subnet n.n.n.n

Where n is a three-
digit number
(0-255)

4-byte
integer

The library’s IP Subnet address. To
change this value, use the library’s
operator panel.

cfgIPMask IP Mask n.n.n.n

Where n is a three-
digit number
(0-255)

4-byte
integer

The library’s IP Mask address. To
change this value, use the library’s
operator panel.

cfgIPGateway IP Gateway
Address

n.n.n.n

Where n is three-digit
number (0-255)

4-byte
integer

The library’s IP gateway address.
To change this value, use the
library's operator panel.

cfgMACAddress MAC Address h

Where h is a
hexadecimal number.

6-byte
hexa-
decimal
number

The library's Ethernet physical
address, which is assigned by the
Ethernet adapter's manufacturer.

cfgFTProtocol File Transfer
Protocol

Alphanumeric string,
up to 20 characters
(upper or lower case)

String The protocol used for file transfer.
Exabyte libraries use FTP.

cfgFTUserName File Transfer
User Name

Alphanumeric string,
up to 20 characters
(upper or lower case)

String

cfgFTPassword File Transfer
Password

Alphanumeric string,
up to 20 characters
(upper or lower case)

String

The user name and password
allow secure transfer of library and
Ethernet firmware upgrades via
FTP.

The default User Name is
“anonymous.” The default
password is “Exabyte.”

The user name and password can
be changed using Library Monitor
(see page 29).

cfgSCSISecurityOn SCSI Security
Enabled

Unknown (0)
No (1)
Yes (2)

4-byte
Boolean
integer

Indicates whether security has
been enabled using a SCSI
command.

cfgFrontPanelSecurityOn Front Panel
Security Enabled

Unknown (0)
No (1)
Yes (2)

4-byte
Boolean
integer

Indicates whether security has
been enabled from the library's
front panel.

cfgFrontPanelPassword Front Panel
Password

nnnn

Where n is an integer
(0-9)

4-byte
integer

The library’s security password that
was entered from the operator
panel when front panel security
was enabled. The default front
panel password is 000.
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MIB Field Name Default User
Field Name

Display Value
(Raw Data)

SNMP
Data
Type

Description

cfgBCSPresent Bar Code
Scanner Present

Unknown (0)
No (1)
Yes (2)

4-byte
Boolean
integer

Indicates whether a bar code
scanner is installed in the library.

cfgBCSVerifyChecksum Bar Code
Scanner Verify
Checksum

Unknown (0)
No (1)
Yes (2)

4-byte
Boolean
integer

Indicates whether the Verify
Barcode Checksums option is
enabled.

cfgBCSScanDuringPost Scan Bar Codes
during POST

Unknown (0)
No (1)
Yes (2)

4-byte
Boolean
integer

Indicates whether the Post Bar
Code scan option is enabled.

cfgMAMPresent MAM Reader
Present

Unknown (0)
No (1)
Yes (2)

4-byte
Boolean
integer

Indicates whether Memory
Auxiliary Memory (MAM) is
implemented in the library.

cfgMSEFirstElementIndex Cartridge Slot
First Element
Index

n

Where n is an integer

4-byte
integer

The element index of the first data
storage element (cartridge slot).

cfgMSELastElementIndex Cartridge Slot
Last Element
Index

n

Where n is an integer

4-byte
integer

The element index of the last data
storage element (cartridge slot). If
desired, the library can be
configured to use fewer than the
maximum number of data storage
elements using the Max
Addressable Slot option on the
LCD Configuration menu.

cfgMSEMaxCount # Cartridge Slots
Max

n

Where n is an integer

4-byte
integer

The maximum number of data
storage elements (cartridge slots)
in the library.

cfgMSEInstalledCount # Cartridge Slots
Installed

n

Where n is an integer

4-byte
integer

The number of data storage
elements (cartridge slots) currently
installed in the library.e

cfgMAEFirstElementIndex Drive First
Element Index

n

Where n is an integer

4-byte
integer

The element index of the first data
access element (tape drive).

cfgMAELastElementIndex Drive Last
Element Index

n

Where n is an integer

4-byte
integer

The element index of the last data
access element (tape drive).

cfgMAEMaxCount # Drives Max n

Where n is an integer

4-byte
integer

The maximum number of data
access elements (tape drives) in
the library.

cfgMIEFirstElementIndex Entry-Exit Port
First Element
Index

n

Where n is an integer

4-byte
integer

The element index of the first
entry/exit port element.

cfgMIELastElementIndex Entry-Exit Port
Last Element
Index

n

Where n is an integer

4-byte
integer

The element index of the last
entry/exit port element.

cfgMIEMaxCount # Entry-Exit
Ports Max

n

Where n is an integer

4-byte
integer

The maximum number of entry/exit
port elements in the library.

cfgMTEFirstElementIndex Robot First
Element Index

n

Where n is an integer

4-byte
integer

The element index of the first
transport element (robot).

cfgMTELastElementIndex Robot Last
Element Index

n

Where n is an integer

4-byte
integer

The element index of the last
transport element (robot).
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MIB Field Name Default User
Field Name

Display Value
(Raw Data)

SNMP
Data
Type

Description

cfgMTEMaxCount # Robots Max n

Where n is an integer

4-byte
integer

The maximum number of transport
elements (robots) in the library.

cfgHostInterfaceType Host Interface
Type

None (1)
SCSI (2)
Fibre Channel (3)

4-byte
integer

The type of interface connecting
the host to the library.

cfgSCSIType SCSI Type None (1)
HVD (2)
LVD, LVD Mode (3)
LVD, SE Mode (4)
LVD, HVD Mode (5)

4-byte
integer

The type of SCSI interface the
library is attached.

cfgSCSIid SCSI ID n

Where n is an integer
(0 – 15)

4-byte
integer

The SCSI ID for the library.

cfgFCWorldWideNameNode Library FC Node
WWN

iiiiiiiiFFFFhhhhhh

Where iiiiiiii is the
hexadecimal
representation of the
manufacturer’s IEEE
company ID and h is
a hexadecimal
number (0 – F)
representing the
individual device ID

8 byte
hexa-
decimal
number

The worldwide name of the library
on a Fibre Channel network.

cfgFCWorldWideNamePort1 Library FC port 1
WWN

iiiiiiiiFFFFhhhhhh

Where iiiiiiii is the
hexadecimal
representation of the
manufacturer’s IEEE
company ID and h is
a hexadecimal
number (0 – F)
representing the
individual device ID

8 byte
hexa-
decimal
number

The worldwide name for library
port 1 on a Fibre Channel network.

cfgFCWorldWideNamePort2 Library FC port 2
WWN

iiiiiiiiFFFFhhhhhh

Where iiiiiiii is the
hexadecimal
representation of the
manufacturer’s IEEE
company ID and h is
a hexadecimal
number (0 – F)
representing the
individual device ID

8 byte
hexa-
decimal
number

The worldwide name for library
port 2 on a Fibre Channel network.

cfgAutoCleanEnabled Auto Clean
Enabled

Unknown (0)
No (1)
Yes (2)

4-byte
Boolean
integer

Indicates whether the Autoclean
option is enabled.

cfgCSRemainingCleanCount Remaining Clean
Count

n

Where n is an integer

4-byte
integer

The number of cleaning cycles
remaining on the installed cleaning
cartridge.
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MIB Field Name Default User
Field Name

Display Value
(Raw Data)

SNMP
Data
Type

Description

cfgCSEnabled Clean Slot
Enabled

Unknown (0)
No (1)
Yes (2)

4-byte
Boolean
integer

Indicates whether the Clean Slot
option is enabled.f

cfgCSStorageElementIndex Clean Slot
Element Index

n

Where n is an integer

4-byte
integer

The element index of the cartridge
slot assigned to the cleaning
cartridge.

Library Statistics

stsCurrentDate Current Date mm/dd/yyyy, numeric
string, up to
10 characters

String The current date (set from the
library’s front panel).g

stsCurrentTime Current Time hh:mm:ss, numeric
string, up to
8 characters

String The current time (set from the
library’s front panel).g

stsPowerOnSeconds Power On Time
(sec)

n

Where n is an integer

4-byte
integer

The total power-on time of the
library in seconds.h

stsErrorCode Error Code n

Where n is an integer

4-byte
integer

The numeric error code displayed
on the library LCD. A value of zero
indicates that there is no error code
displayed on the LCD.

stsErrorText Error Message Alphanumeric string,
up to 20 characters

String The error code text displayed on
the library LCD.

stsIsReserved Library Reserved Unknown (0)
No (1)
Yes (2)

4-byte
Boolean
integer

Indicates whether the library has
been reserved by a host.

stsHOSTSCSIid SCSI ID of
Reserving Host

n

Where n is an integer
(0 – 15)

4-byte
integer

The SCSI ID of the host that issued
a RESERVE command.

stsTotalMoveCount Total Moves n

Where n is an integer

4-byte
integer

The total number of times the robot
has picked a cartridge and placed
it in a slot or a drive.

stsTotalPickRetryCount Total Pick
Retries

n

Where n is an integer

4-byte
integer

The total number of times the robot
retried picking a cartridge from a
slot or a drive.

stsTotalPutRetryCount Total Put Retries n

Where n is an integer

4-byte
integer

The total number of times the robot
retried placing a cartridge into a
slot or a drive.

stsTotalScanCount Total Bar Code
Scans

n

Where n is an integer

4-byte
integer

The total number of times the robot
scanned a bar code label.

stsTotalScanRetryCount Total Bar Code
Scan Retries

n

Where n is an integer

4-byte
integer

The total number of times the robot
retried scanning a bar code label.

stsTotalScanFailureCount Total Bar Code
Scan Failures

n

Where n is an integer

4-byte
integer

The total number of times the
library failed to scan a bar code.

stsTotalIEPortCycleCount Total Entry-Exit
Port Cycles

n

Where n is an integer

4-byte
integer

The total number of times the
entry/exit port has extended and
retracted or locked and unlocked.
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MIB Field Name Default User
Field Name

Display Value
(Raw Data)

SNMP
Data
Type

Description

stsTotalSnugRetryCount Total Snug
Retries

n

Where n is an integer

4-byte
integer

The total number of times the robot
squared up the cartridge in the
gripper before placing it in a slot or
a drive.i

stsPowerUpCycleCount Power Up Cycle
Count

n

Where n is an integer

4-byte
integer

The total number of times the
library has been power cycled.

stsOMLine1 Operator
Message Line 1

Alphanumeric string,
up to 20 characters
(upper and lower
case)

String The text that the library displays for
the first user-writable line of the
LCD Status screen.g

stsOMLine2 Operator
Message Line 2

Alphanumeric string,
up to 20 characters
(upper and lower
case)

String The text that the library displays for
the second user-writable line of the
LCD Status screen.g

stsOMLine3 Operator
Message Line 3

Alphanumeric string,
up to 20 characters
(upper and lower
case)

String The text that the library displays for
the third user-writable line of the
LCD Status screen.g

stsLMLine1 Library Message
Line 1

Alphanumeric string
(upper and lower
case)

String The text that the library displays for
the first message line of the LCD
Status screen.a

stsLMLine2 Library Message
Line 2

Alphanumeric string
(upper and lower
case)

String The text that the library displays for
the second message line of the
LCD Status screen.a

Cartridge Slot (Storage Element) Information

mseTableSize # Cartridge Slots n

Where n is an integer

4-byte
integer

The total number of cartridge slots
configured in the library. This value
can be changed using Max
Addressable Slot option.

mseIndex Cartridge Slot
Element Index

n

Where n is an integer

4-byte
integer

The element index for the cartridge
slot.

mseAddress Cartridge Slot
Element Address

n

Where n is an integer

4-byte
integer

The element address for the
cartridge slot.

msePresent Cartridge Slot
Present

Unknown (0)
No (1)
Yes (2)

4-byte
Boolean
integer

Indicates whether the cartridge slot
is present. If a magazine is
installed, its cartridge slots are
always present.

mseOccupied Cartridge Slot
Occupied

Unknown (0)
No (1)
Yes (2)

4-byte
Boolean
integer

Indicates whether there is a
cartridge in the cartridge slot.

mseAccessible Cartridge Slot
Accessible

Unknown (0)
No (1)
Yes (2)

4-byte
Boolean
integer

Indicates whether the robot can
access the cartridge. The cartridge
storage location is accessible if the
cartridge magazine is installed.

msePrimaryVolumeTag Volume ID of
Cartridge in Slot

Alphanumeric string,
up to 36 characters

String The volume tag (bar code label)
information of the cartridge in this
storage location.
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MIB Field Name Default User
Field Name

Display Value
(Raw Data)

SNMP
Data
Type

Description

msePrimaryVolumeTagValid Volume ID of
Cartridge is Valid

Unknown (0)
No (1)
Yes (2)

4-byte
Boolean
integer

Indicates whether the Volume ID
for the cartridge is valid.

mseSourceAddress Cartridge Source
Address

n

Where n is an integer

4-byte
integer

The element index of the element
from which the cartridge was last
moved.

mseSourceAddressValid Cartridge Source
Address Valid

Unknown (0)
No (1)
Yes (2)

4-byte
Boolean
integer

Indicates whether the cartridge
source address is valid.

mseReserved Cartridge Slot
Reserved

Unknown (0)
No (1)
Yes (2)

4-byte
Boolean
integer

Indicates whether the cartridge slot
is reserved.

mseReserveHostSCSIid SCSI ID of
Reserving Host

n

Where n is an integer
(0 – 15)

4-byte
integer

Displays the SCSI ID of the host
that issued a RESERVE command.

mseReserveValueKey Reservation Key n

Where n is an integer

4-byte
integer

A number assigned by a host when
it reserved the element.

Tape Drive (Access Element) Information

maeTableSize # Drives n

Where n is an integer

The maximum number of tape
drives in the library.

maeIndex Drive Element
Index

n

Where n is an integer

4-byte
integer

The element index for the tape
drive.

maeAddress Drive Element
Address

n

Where n is an integer

4-byte
integer

The element address for the tape
drive.

maePresent Drive Present Unknown (0)
No (1)
Yes (2)

4-byte
Boolean
integer

Indicates whether the tape drive is
present.

maeOccupied Drive has a
Cartridge

Unknown (0)
No (1)
Yes (2)

4-byte
Boolean
integer

Indicates whether there is a
cartridge in the tape drive.

maeAccessible Drive Accessible Unknown (0)
No (1)
Yes (2)

4-byte
Boolean
integer

Indicates whether the robot can
pick or place a cartridge at the tape
drive location. The tape drive is
accessible if a cartridge is not
loaded or the tape drive is empty.

maePrimaryVolumeTag Volume ID of
Cartridge in
Drive

Alphanumeric string,
up to 36 characters

String The volume tag (bar code label)
information of the cartridge in the
tape drive.

maePrimaryVolumeTagValid Volume ID of
Cartridge is Valid

Unknown (0)
No (1)
Yes (2)

4-byte
Boolean
integer

Indicates whether the Volume ID
for the cartridge is valid.

maeSourceAddress Cartridge Source
Address

n

Where n is an integer

4-byte
integer

The element index of the element
from which the cartridge was last
moved.

maeSourceAddressValid Cartridge Source
Address Valid

Unknown (0)
No (1)
Yes (2)

4-byte
Boolean
integer

Indicates whether the cartridge
source address is valid.
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MIB Field Name Default User
Field Name

Display Value
(Raw Data)

SNMP
Data
Type

Description

maeReserved Drive Reserved Unknown (0)
No (1)
Yes (2)

4-byte
Boolean
integer

Indicates whether the cartridge slot
is reserved.

maeReserveHostSCSIid SCSI ID of
Reserving Host

n

Where n is an integer
(0 – 15)

4-byte
integer

The SCSI ID of the host that issued
a RESERVE command.

maeReserveValueKey Reservation Key n

Where n is an integer

4-byte
integer

A number assigned by a host when
it reserved the element.

maeSCSIid Drive SCSI ID n

Where n is an integer
(0 – 15)

4-byte
integer

The SCSI ID of the tape drive.

maeDriveType Drive Type Unknown (0)
Sony 4mm (1)
HP 4mm (2)
Conner 4mm (3)
Mammoth (4)
DLT-4000 (5)
DLT-7000 (6)
EXB-8505 (7)
EXB-8205 (8)
EXB-8505XL (9)
EXB-8205XL (10)
Eliant-820 (11)
Blank (12)
Sony AIT (13)
Mammoth-2 (14)
Seagate LTO (15)
HP LTO (16)
IBM LTO (17)
DLT-8000 (18)
Fujitsu LTO (19)
SuperDLT (20)

4-byte
integer

The type of tape drive installed.

maeInqVendorID Drive Vendor ID Alphanumeric string,
up to 8 characters

String The ASCII representation of the
Vendor ID returned by the tape
drive in response to an INQUIRY
command.g

maeInqProductID Drive Product ID Alphanumeric string,
up to 16 characters

String The ASCII representation of the
tape drive Product ID returned by
the tape drive in response to an
INQUIRY command.g

maeInqProductRevision Drive Product
Revision

Alphanumeric string,
up to 4 characters

String The ASCII representation of the
Product Revision level returned by
the tape drive in response to an
INQUIRY command.

maeInqSerialNumber Drive Serial
Number

Alphanumeric string,
up to 10 characters

String The ASCII representation of the
tape drive’s serial number.

maeDriveLCDText Drive LCD Text Alphanumeric string,
up to 20 characters

String The message displayed on the
tape drive LCD.

maeLoadCount Drive Load
Count

n

Where n is an integer

4-byte
integer

The number of times the robot
loaded a cartridge into the tape
drive.
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MIB Field Name Default User
Field Name

Display Value
(Raw Data)

SNMP
Data
Type

Description

maeReloadCount Drive Reload
Count

n

Where n is an integer

4-byte
integer

The number of times the robot
reloaded a cartridge into the tape
drive.

maeDoublePickCount Drive Double
Pick Count

n

Where n is an integer

4-byte
integer

The number of times the robot had
to grab a cartridge twice to remove
it from the tape drive.i

maeFCWorldWideNameNode Drive FC Node
WWN

iiiiiiiiFFFFhhhhhh

Where iiiiiiii is the
hexadecimal
representation of the
manufacturer’s IEEE
company ID and h is
a hexadecimal
number (0 – F)
representing the
individual device ID

8 byte
hexa-
decimal
number

The worldwide name of the tape
drive on a Fibre Channel network.

maeFCWorldWideNamePort1 Drive FC Port 1
WWN

iiiiiiiiFFFFhhhhhh

Where iiiiiiii is the
hexadecimal
representation of the
manufacturer’s IEEE
company ID and h is
a hexadecimal
number (0 – F)
representing the
individual device ID

8 byte
hexa-
decimal
number

The worldwide name for tape drive
port 1 on a Fibre Channel network.

maeFCWorldWideNamePort2 Drive FC Port 2
WWN

iiiiiiiiFFFFhhhhhh

Where iiiiiiii is the
hexadecimal
representation of the
manufacturer’s IEEE
company ID and h is
a hexadecimal
number (0 – F)
representing the
individual device ID

8 byte
hexa-
decimal
number

The worldwide name for tape drive
port 2 on a Fibre Channel network.

maeCVFLASHVersion Drive Firmware
Version

Alphanumeric string,
up to 20 characters

String The tape drive flash code version.
For more information about the
latest flash code for your tape
drive, refer to Exabyte Firmware
Upgrades in the Support Services
section of the Exabyte web site.

maeCVEEPROMVersion Drive EEPROM
Version

Alphanumeric string,
up to 20 characters

String The tape drive firmware version.
For more information about the
latest firmware version for your
tape drive, refer to Exabyte
Firmware Upgrades in the Support
Services section of the Exabyte
web site.
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MIB Field Name Default User
Field Name

Display Value
(Raw Data)

SNMP
Data
Type

Description

maeCVBOOTVersion Drive Boot
Version

Alphanumeric string,
up to 20 characters

String The tape drive boot code version.
For more information about the
latest boot code for your tape drive,
refer to Exabyte Firmware
Upgrades in the Support Services
section of the Exabyte web site.

Entry/Exit Port (Import/Export Element) Information

mieTableSize # Entry-Exit
Ports

n

Where n is an integer

4-byte
integer

The number of entry/exit port
elements in the library.j

mieIndex Entry-Exit Port
Element Index

n

Where n is an integer

4-byte
integer

The element index of each slot in
the entry/exit port.j

mieAddress Entry-Exit Port
Element Address

n

Where n is an integer

4-byte
integer

The element address of each slot
in the entry/exit port.j

miePresent Entry-Exit Port
Present

Unknown (0)
No (1)
Yes (2)

4-byte
Boolean
integer

Indicates whether the entry/exit
port is present.

mieOccupied Entry-Exit Port
has a Cartridge

Unknown (0)
No (1)
Yes (2)

4-byte
Boolean
integer

Indicates whether there is a
cartridge in the selected entry/exit
port slot.

mieAccessible Entry-Exit Port
Accessible

Unknown (0)
No (1)
Yes (2)

4-byte
Boolean
integer

Indicates whether the robot can
access the entry/exit port.k

miePrimaryVolumeTag Volume ID of
Cartridge in
Entry-Exit Port

Alphanumeric string,
up to 36 characters

String The volume tag (bar code label)
information of the cartridge in the
entry/exit port.

miePrimaryVolumeTagValid Volume ID of
Cartridge is Valid

Unknown (0)
No (1)
Yes (2)

4-byte
Boolean
integer

Indicates whether the Volume ID
for the cartridge is valid.

mieSourceAddress Cartridge Source
Address

n

Where n is an integer

4-byte
integer

The element index of the element
from which the cartridge was last
moved.

mieSourceAddressValid Cartridge Source
Address is Valid

Unknown (0)
No (1)
Yes (2)

4-byte
Boolean
integer

Indicates whether the cartridge
source address is valid.

mieReserved Entry-Exit Port
Reserved

Unknown (0)
No (1)
Yes (2)

4-byte
Boolean
integer

Indicates whether the entry/exit
port slot is reserved.

mieReserveHostSCSIid SCSI ID of
Reserving Host

n

Where n is an integer
(0 – 15)

4-byte
integer

The SCSI ID of the host that issued
a RESERVE command.

mieReserveValueKey Reservation Key n

Where n is an integer

4-byte
integer

A number assigned by a host when
it reserved the element.
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MIB Field Name Default User
Field Name

Display Value
(Raw Data)

SNMP
Data
Type

Description

Robot (Media Transport ) Information

mteTableSize # Robots n

Where n is an integer

4-byte
integer

The number of robots installed in
the library.

mteIndex Robot Element
Index

n

Where n is an integer

4-byte
integer

Indicates the element index of the
robot.

mteAddress Robot Element
Address

n

Where n is an integer

4-byte
integer

Indicates the element address of
the robot.

mtePresent Robot Present Unknown (0)
No (1)
Yes (2)

4-byte
Boolean
integer

Indicates whether the robot is
present.

mteOccupied Robot has a
Cartridge

Unknown (0)
No (1)
Yes (2)

4-byte
Boolean
integer

Indicates whether there is a
cartridge in the robot.

mteAccessible Robot
Accessible

Unknown (0)
No (1)
Yes (2)

4-byte
Boolean
integer

Indicates whether the robot
contains a cartridge. The robot is
not accessible if it contains a
cartridge.

mtePrimaryVolumeTag Volume ID of
Cartridge in
Robot

Alphanumeric string,
up to 36 characters

String The volume tag (bar code label)
information of the cartridge in the
robot.

mtePrimaryVolumeTagValid Volume ID of
Cartridge is Valid

Unknown (0)
No (1)
Yes (2)

4-byte
Boolean
integer

Indicates whether the Volume ID
for the cartridge is valid.

mteSourceAddress Cartridge Source
Address

n

Where n is an integer

4-byte
integer

The element index of the element
from which the cartridge was last
moved.

mteSourceAddressValid Cartridge Source
Address is Valid

Unknown (0)
No (1)
Yes (2)

4-byte
Boolean
integer

Indicates whether the cartridge
source address is valid.

mteReserved Robot is
Reserved

Unknown (0)
No (1)
Yes (2)

4-byte
Boolean
integer

Indicates whether the robot is
reserved.

mteReserveHostSCSIid SCSI ID of
Reserving Host

n
Where n is an integer
(0 – 15)

4-byte
integer

The SCSI ID of the host that issued
a RESERVE command.

mteReserveValueKey Reservation Key n
Where n is an integer

4-byte
integer

A number assigned by a host when
it reserved the element.

Power Supply Information

pstTableSize # Power Supply
Sensors

n
Where n is an integer

4-byte
integer

The number of power supply
sensors installed in the library.i

pstStatus Power Supply
Status

Unknown (0)
OK (1)
Failed (2)

4-byte
Boolean
integer

The status of each installed power
supply.
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MIB Field Name Default User
Field Name

Display Value
(Raw Data)

SNMP
Data
Type

Description

Fan Information

sfTableSize # Fans in
System

n
Where n is an integer

4-byte
integer

The number of fans installed in the
library.

sfStatus Fan Status Unknown (0)
OK (1)
Failed (2)

4-byte
Boolean
integer

The status of each installed fan.

sfFanString Fan Name Alphanumeric string,
up to 20 characters

String The name of the fan (for example,
library fan or tape drive fan).

System Sensors

seDoorPresent Door Present Yes (2) 4-byte
Boolean
integer

Indicates whether the library door
is present. This value is always
“yes.”

seDoorLocked Door Locked Unknown (0)
No (1)
Yes (2)

4-byte
Boolean
integer

Indicates whether the library door
is locked.

seDoorClosedSensor1 Door Closed -
Sensor 1

Unknown (0)
No (1)
Yes (2)

4-byte
Boolean
integer

Indicates whether the first front
door sensor is activated.

seDoorClosedSensor2 Door Closed -
Sensor 2

Unknown (0)
No (1)
Yes (2)

4-byte
Boolean
integer

Indicates whether the second front
door sensor is activated.

ssIERetracted Entry-Exit Port
Retracted/
Locked

Unknown (0)
No (1)
Yes (2)

4-byte
Boolean
integer

Indicates whether the entry/exit
port is locked (or retracted).

ssIEExtended Entry-Exit Port
Extended/
Unlocked

Unknown (0)
No (1)
Yes (2)

4-byte
Boolean
integer

Indicates whether the entry/exit
port is unlocked (or extended).

ssIEDoorOpen Entry-Exit Port
Door Open

Unknown (0)
No (1)
Yes (2)

4-byte
Boolean
integer

Indicates whether the entry/exit
port door is open.l

pssTableSize # Product
Specific Sensors

n
Where n is an integer

4-byte
integer

The total number of sensors in the
library.

pssSensorType Sensor Type 1 = Boolean
2 = Integer

4-byte
integer

The type of sensor.

pssSensorValue Sensor Value Boolean sensors:
  Unknown (0)
  No (1)
  Yes (2)
Integer sensors:
n , where n is an
integer

4-byte
integer

The value returned by each sensor
in the library.

pssSensorString Sensor Name Alphanumeric string,
up to 20 characters

String The name of each sensor in the
library.
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Table Footnotes
a For the Exabyte 110L, 215M, 221L, and 430M libraries, the product name can be up to 16 characters. For the Exabyte 230D, 690D,

X80, and X200 libraries, the product name can be up to 20 characters.
b For the Exabyte 110L, 215M, 221L, and 430M libraries, this field is read-only. For the Exabyte 230D, 690D, X80, and X200 libraries,

this field is read/write.
c For the Exabyte 110L, 215M, 221L, and 430M libraries, this field is always blank. For the Exabyte 230D, 690D, X80, and X200

libraries, this field shows the current boot or flash version stored in the library Ethernet card.
d The Exabyte 110L, 215M, 221L, and 430M libraries currently only support static IP addressing.
e The maximum number of slots in the Exabyte 110L, 215M, 221L, and 430M libraries cannot be changed. For the Exabyte 230D, 690D,

X80, and X200 libraries, the number of installed slots can be changed.
f The cleaning slot is always enabled (cfgCSEnabled=1) for the Exabyte 230D, 690D, X80, and X200 libraries.
g For the Exabyte 110L, 215M, 221L, and 430M libraries, this field is blank.
h For the Exabyte 230D, 690D, X80, and X200 libraries, this field is zero.
i For the Exabyte 110L, 215M, 221L, and 430M libraries, the value for this field is zero.
j For the Exabyte 221L, and 430M libraries, there is only one slot (element) in the entry exit port. For the Exabyte 690D, X80, and X200

libraries there are five slots (elements) in the entry/exit port. The Exabyte 230D, 110L, and 215M libraries do not have an entry exit
port.

k For the Exabyte 110L, 215M, 221L, and 430M libraries, the entry/exit port is accessible if the cartridge magazine or caddy is installed
and locked. For the Exabyte 230D, 690D, X80, and X200 libraries, the entry/exit port is accessible if it is retracted.

l For the Exabyte 110L, 215M, 221L, and 430M libraries, the value for this field is one.
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Index

A

autosize columns, 12, 18

AutoSize Rows, 12

C

code load, 23

Community Strings
Broadcast, 33
Read, 8
Write, 30

Configure menu, options, 12

configuring Library Monitor, 27

contacting Exabyte, vi

customizing the data display, 13

D

data field
autosize columns, 18
diplay/hide, 14
display order, 14
select colors, 17, 18
select fonts, 17
user name, 14

default file locations, specifying, 29

diagnostic listing
creating, 25
size, 26
viewing, 26

display list
automatic update, 19
creating custom lists, 18
current, 10
formatting, 16
modifying, 13
polling interval, 19
predefined, 31
using highlights, 20

Display menu, options, 11

display panel
description, 10
sizing columns and rows, 12
updating, 10

display raw data, 15

display/hide data fields, 14

dump. See diagnostic listing

F

field definitions, Exabyte library MIB, 32

File menu, options, 11

firmware
obtaining new, 23
updating library, 23

Fit to Window, 12

formatting a display list, 16

FTP password
changing, 30
viewing, 30

FTP username
changing, 30
viewing, 30

G

groups
defining, 28
deleting, 29

H

highlights
creating, 20
define conditions, 22
define reset, 22
deleting, 23
description, 20
modifying, 23
select color, 21
select font, 21
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I

installing Library Monitor, 2

L

library
adding to groups, 28
adding to Library Monitor, 8, 27
changing name, 30
changing name of physical location, 30
current, 10
defining groups, 8, 28
redefining in Library Monitor, 28
removing from a group, 29
removing from Library Monitor, 28
updating firmware, 23

Library Monitor
adding a library, 27
compatibility with Exabyte MIB levels, v
Configure menu, 12
configuring, 27
default file locations, 29
defining groups, 28
Display menu, 11
File menu, 11
initial configuration, 7
initial start up, 6
installation requirements, 1
installing, 2
main window, 9
obtaining current version, 1
online help, 5
overview, v
quitting, 5
required equipment and software, 1
standard display lists, 31
starting, 4
supported libraries, v
uninstalling, 4
using to update library firmware, 23
Window menu, 12

M

MIB
definition, v
definition update, 6
field definitions, 32

FTP Password, 30
FTP Username, 30
library name, 30
library physical location, 30
modifying data, 29
OID address, 14

modifying a display list, 13

O

overview of Library Monitor, v

P

Pause button, suspending polling, 10

polling interval
current status, 10
definition, v
setting, 19
status, 10

R

Read Community String, 8

Refresh button, using to update the display, 10

Reset, 12

Resume button, using to resume polling, 10

S

status icons, descriptions, 9

T

trace. See diagnostic listing

U

uninstalling Library Monitor, 4

W

Window menu, options, 12

Write Community String, viewing, 30

Write Dump. See diagnostic listing
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